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Abstract. As educational systems move from onsite to online due to the COVID-19 pan-
demic, teachers face the difficulty of designing online examination formats which minimise
opportunities for dishonesty. In this paper, we expose our design of such a format: a protected
Microsoft Excel spreadsheet containing short-answer questions, which was implemented in
a calculus module taught by us. This format allows examiners to randomise questions with
the aim that each student receives each question with different numerical details, making
plagiarism impossible, while keeping the marking effort very low.

1. Introduction

In March 2020, the worldwide-spreading COVID-19 pandemic has forced a sudden tran-
sition in educational systems from onsite to online. For subjects which do not require face-
to-face activities such as laboratory sessions, most lecturers may find no significant difficulty
in delivering teaching materials online: asynchronously (e.g., in a pre-recorded video) or
synchronously (e.g., in a videoconference which allows real-time interactions with students).
However, when it comes to the assessment of students’ performance, the problem of design-
ing an objective, dishonesty-proof online examination mechanism remains largely unsettled.
The difficulty —perhaps impossibility— of guaranteeing that online examinations are free
from cheating opportunities has raised broad concern [4, 12, 11] even before the pandemic
[6, 8, 15, 18, 7, 16, 10].

As a survey has revealed1, students feel that they are almost four times more likely, and
that their classmates are over five times more likely, to commit an academic dishonesty
in an online class than in an onsite class [18, Table 6]. Upon their first-glance of online
examination questions, students would complete the examination individually if they feel
sufficiently confident to do so, otherwise they would copy these questions and paste them on
an online forum of classmates where they look for assistance [6, page 933]. The latter could
ultimately be in the form of (a photograph of) a classmate’s already-completed answer sheet
—which can be uploaded very easily to the forum— to be plagiarised by, possibly, all students
in the forum who are currently working on the same examination.

The opportunity for such dishonesties is wide open in every online examination. Meanwhile,
the evidence, which usually can only be acquired from the students’ submitted answer sheets,
albeit often triggering suspicion, is rarely definitive enough for a penalty imposition (unless, for

E-mail address: j.hoseana@unpar.ac.id, orizastepanus@unpar.ac.id, elvinaos@unpar.ac.id.
1This survey was given to 635 students of an Appalachian university, as reported by Watson & Sottile [18].
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instance, a student accidentally submitted another student’s answer sheet instead of his/her
own). Many examiners thus have no choice but to omit many alleged cases of dishonesty.

Such a situation raises a challenge for examiners. If no action is taken, research has shown,
there will be widespread cheating [4, page 199]. Possible actions already put forward in the
literature include the use of cameras [4], a developed software [7], miscellaneous technologies
[12], and paraphrasing [10]; modification of the assessment format [13]; and various practical-
ities [16].

In a certain academic year, the three authors were assigned as a team to online-teach
the two calculus modules designed for first-year undergraduate students in a mid-sized, non-
mathematics department within the aforenamed university: Calculus 1 in the odd semester
and Calculus 2 in the even semester. These modules cover a wide range of topics albeit only
to a modest depth, consisting of standard first-year calculus materials, and some elementary
linear algebra materials at the end of Calculus 2. Each module is assessed by —apart from
several formative assignments— both a mid-term examination covering all first trimester
materials and a final examination covering all second trimester materials. The team, therefore,
has organised a total of four examinations in the mentioned academic year. Each examination
was online and individual, making present the examiners’ challenge described earlier.

Our first examination —the mid-term examination of Calculus 1— is the closest one to an
onsite examination in terms of its design: a set of three essay questions were uploaded in the
beginning of the two-hour2 examination period in the form of a PDF document; students were
to handwrite their answers on pieces of paper, scan or photograph them, and upload them
in the form of a PDF document by the end of the examination period. From the submitted
answers, some indications of collaborations were noticeable, albeit, as previously remarked,
did not form sufficiently solid evidence for a sanction. Nevertheless, we —without saying
anything to the students— kept in mind several groups of two to three students who, due to
their exceptionally similar answer layouts, were alleged to collaborate.

In our second examination —the final examination of Calculus 1— we implemented a pro-
tocol which prevented the groups allegedly collaborating in the previous exam to collaborate
again. We assigned to each student a different integer formed by three non-zero digits, which
we refer to as the student’s examination code. Before the examination began, each student
was made aware of his/her examination code, but not at all of how this code will be used in
the examination. The latter was made to become clear only on the day of the examination,
by the instructions for each question read by the students. See Figure 1 and its caption
for (an English translation of) the third question on the examination paper, and some ex-
planation. With this protocol, students, given that they were unlikely to expect such an
organised randomisation system, were hoped to be more inclined towards completing the ex-
amination independently than seeking help from their classmates who —as they knew— had
different examination codes, thereby hopefully reducing dishonesties. Indeed, less evidence of
dishonesties was found in this second examination.

Our third examination —the mid-term examination of Calculus 2— was organised in a way
similar to our second examination, albeit with only two —rather than three— different types
for each of the three questions. This time we found slightly more evidence of dishonesties,
perhaps because of not only the reduction of the number of question types but also the
fact that the students were already familiar with the examination mechanism which made it
possible for some of them to have devised some collaboration plans.

2This duration applies to all of our examinations, including the fourth one.

2



QUESTION 3

If the third digit of your examination code is 1, 2, or 3, attempt TYPE A.

If the third digit of your examination code is 4, 5, or 6, attempt TYPE B.

If the third digit of your examination code is 7, 8, or 9, attempt TYPE C.

TYPE A

(a) Using logarithmic differentiation, determine the value of y′ for x = 0
if:

(i) y =

√
4 + 5 sinx

x3 + x+ 1
. (ii) y = (x+ 1)e

√
x+1+3

.

(b) Using L’Hôpital’s theorem, determine the value of

lim
x→−∞

(2x− 3) arctan

(
− 3

x

)
.

TYPE B

(a) Using logarithmic differentiation, determine the value of y′ for x = 0
if:

(i) y =

√
9 + 2 sinx

x3 + x+ 1
. (ii) y = (x+ 1)e

√
x+1−3

.

(b) Using L’Hôpital’s theorem, determine the value of

lim
x→−∞

(3x+ 1) arctan

(
− 4

x

)
.

TYPE C

(a) Using logarithmic differentiation, determine the value of y′ for x = 0
if:

(i) y =

√
1 + 3 sinx

x2 + x+ 1
. (ii) y = (x+ 1)e

3−
√

x+1

.

(b) Using L’Hôpital’s theorem, determine the value of

lim
x→−∞

(4x− 1) arctan

(
1

x

)
.

Figure 1. The third question of our final examination of Calculus 1. Notice
how we let the third digit of the student’s examination code determine which
one of the three different types of the question (A, B, or C, differing only on
numerical details) should be attempted by the student. The examination itself
consisted of three questions; the same protocol was applied to the first and sec-
ond questions using, respectively, the first and second digits of the examination
codes. This protocol was not made known to students before the examination,
making preparations for collaborating impossible. The examination codes of
all students were first generated randomly in Microsoft Excel using the for-
mula =RANDBETWEEN(1;9)*100+RANDBETWEEN(1;9)*10+RANDBETWEEN(1;9),
and then carefully edited to prevent the groups allegedly collaborating in the
previous exam from collaborating again: each member of the same group must
be allocated a different type of each question.
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The main purpose of this note is to expose what we did on our fourth examination: the final
examination of Calculus 2. For this examination we designed a completely new examination
format with the aim of achieving an absolute prevention of plagiarism. The underlying wish
was that each student could receive a different type of each question so as not to have a
classmate whose answer is plagiarisable, and thus that every question could have as many
different types as the number of students. For the reader’s information, the number of students
actively enrolled in Calculus 2 was around 80; they were roughly evenly divided into two
parallel classes.

In the upcoming section, we describe how we prepared and randomised the questions.
Subsequently, we describe how we prepared the question paper, which was in the form of
a Microsoft Excel spreadsheet (section 3). We then continue with some discussions on the
marking mechanism (section 4), the guidelines which must be given to students so that they
complete this examination properly and the pre-examination simulation (section 5), and, to
conclude, the strengths and weaknesses of this examination format (section 6).

2. Question preparation and randomisation mechanism

The purpose of this examination was to assess the students’ understanding on the materials
of the second trimester of Calculus 2, which consists of both calculus and elementary linear
algebra materials. Our first radical change from the previous three examinations was that,
for this examination, we used, rather than essay questions, 20 short-answer questions: those
that demand only final answers.3 Since we wished that every student could be assigned a
different type of each question, our first step was to prepare, rather than a set of 20 questions,
a set of 20 families of questions, each of which was made to depend on at least one of the
following ten randomisation parameters:

• α1: the first digit of the student’s year of entry,
• α2: the second digit of the student’s year of entry,
• α3: the third digit of the student’s year of entry,
• α4: the fourth digit of the student’s year of entry,
• β1: the third-to-last digit of the student’s ID number,
• β2: the second-to-last digit of the student’s ID number,
• β3: the last digit of the student’s ID number,
• γ1: the first digit of the student’s examination code,
• γ2: the second digit of the student’s examination code,
• γ3: the third digit of the student’s examination code,

and such that its final answer is an integer —not necessarily positive— which depends on the
involved parameters. The students’ examination codes were the same as the ones used in the
previous examination (the mid-term of Calculus 2).

Clearly, the use of each parameter resulted in a different level of randomisation which
depends on the number of values assumed by the parameter (Figure 2). Using the αis,
for instance, did not result in a significant randomisation, since the values of α1 and α2

were the same for every student (2 and 0 respectively), and only 11 out of 81 students had
(α3, α4) 6= (2, 0); these were the students taking the module for the second time due to not
passing on their first take. We therefore made use of the αis less frequently than the βis and
the γis. Whenever we need a parameter which is desired to be non-zero to prevent a question

3In a normal, non-pandemic situation, this may be suboptimal (cf. section 6 and [5, 19]).
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from being degenerate or trivial, we could always choose one of the γis (or, less preferably,
α1).

Parameter α1 α2 α3 α4 β1 β2 β3 γ1 γ2 γ3
Number of assumed values 1 1 2 4 2 9 10 9 9 9

Figure 2. The number of different values assumed by each parameter.

Let us now present some examples: (the English translations of) some of our actual ques-
tions, discussed along with various aspects related to their designing process. The following
question became Question 4 on the examination paper.

Question 4. Let the density at every point (x, y) on a two-dimensional object in the shape of a
right triangle with vertices (0, 0), (γ2, 0), and (0, γ3) be given by δ(x, y) = 6x+ 6y. Determine
the mass of the object.

Answer 4. γ2γ3 (γ2 + γ3).

This is a question on the application of double integrals to compute the mass of a planar
lamina, which is made to depend on two of the ten mentioned parameters: γ2 and γ3. The
constant 6 in the formula of δ(x, y) was used since it is the most efficient choice which achieves
the question’s admissibility: it is the smallest positive integer c for which the formula δ(x, y) =
cx + cy results in an integer answer for all possible values of γ2 and γ3. Notice also how we
exploited the fact that the γis are non-zero to guarantee the proper existence of the mentioned
triangle.

The following is another example, Question 7 of the examination, whose non-triviality relies
on the fact that α1 and γ2 are both non-zero.

Question 7. Determine the value of p for which the system of linear equations whose aug-
mented matrix is  −2α1 4γ2 1 1

α1 γ2 −2 2
−α1 γ2 p+ γ3 −p


has no solution.

Answer 7. −γ3 + 1.

The above two questions depend on at least two parameters. Let us now present a question
which depends only on one parameter: γ2. Since γ2 ∈ {1, . . . , 9}, this question has only 9
different types, meaning that many students will receive it with exactly the same numerical
details, creating some opportunities for collaboration. To obtain some idea whether such
opportunities were visible enough to —and exploited by— the students, in section 6 we
gather some data and perform a quick check of whether the number of types a question has
correlates with the number of students answering the question correctly.

Question 12. Determine the (3, 3)-entry of the inverse of the matrix

A =

 −1 1 −1
γ2 1 −2
0 −1 1

 .

Answer 12. −γ2 − 1.
5



Instead of demanding the whole matrix A−1, in a question whose answer must be an integer,
we merely demand the value of a particular entry. Another possibility is to demand, instead,
the trace of A−1. To guarantee that the answer is an integer, we designed the matrix A to be
unimodular (see, e.g., [2, Chapter 2]); it has determinant 1 for all choices of γ2. We also used
unimodular matrices as coefficient matrices of systems of linear equations whose solutions
were required to be integral.

Designing such families of questions certainly demands carefulness; computer algebra sys-
tems such as Maple (see, e.g., [17]) provided significant assistance. Fortunately, as most of the
students enrolled in this module were first-year undergraduate students in a non-mathematics
department, the potential of them having the fluency to use such systems during the exami-
nation (compared to that of, e.g., older students in the mathematics department) was on the
limited side.

3. Spreadsheet preparation

Once we have the 20 families of questions and their answers, we began preparing the
examination paper, which is in the form of a Microsoft Excel spreadsheet. In this section we
describe the process in detail. Note that we used Microsoft Excel 20104.

(1) Firstly, after opening a new Microsoft Excel spreadsheet, we shrink and vertically
middle-align the cells as demonstrated in Figure 3. We select all cells (CTRL + A),
click the Format menu on the Home tab, click Column Width (top panel), and set the
column width to 2.00 and click OK (middle panel). Then, we click the middle align
button (bottom panel).

(2) We also decide to use the Times New Roman font globally (Figure 4).

(3) Next, we create the heading of the examination paper by formatting the worksheet as
in Figure 5. In the figure we see, in particular, that students will store the values of
their parameters α1, α2, α3, α4, β1, β2, β3, γ1, γ2, and γ3 in cells M16, N16, O16,
P16, N18, O18, P18, J20, K20, and L20, respectively.

(4) We are now ready to begin typing the questions. Let us first explain how we type
our first question (Figure 6). The original, parametered form of this question is as
follows.

Question 1. Determine the value of∫ α3

0

∫ γ3

2y−3
4xy dx dy.

First, we merge the cells B23 and C23 to become one cell whose format is set to be
text and which stores the question number, “1.” (in bold, for extra emphasis), with
left horizontal alignment (top panel). Then we type the question as it is, exploiting
the small size of the cells to store the symbols as tidily as possible and merging some
nearby cells whenever necessary5. The upper bound of the outer integral, α1, must be
allocated a single cell: N24, in which we type the formula =M16 since the value of α1

4There is not any particular reason for the use of this specific version.
5We took all mathematical symbols from the Symbol menu, thereby making no use of the Equation menu,
which inserts mathematical symbols in the form of moveable objects.
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Figure 3. Shrinking and vertically middle-aligning the cells.

will be stored by students in cell M16 (middle panel). Similarly, in the merged cells
O24 and P24, we type the formula =L20, since the value of γ3, the upper bound of
the inner integral, will be stored by students in L20 (bottom panel). Finally, in line
27, we create a box in which students will type in his/her integer answer.

The next two questions, in their original, parametered form, are:

7



Figure 4. Selecting the Times New Roman font.

Figure 5. The English translation of the heading of the examination paper.

Question 2. Determine the value of a if∫ β2+γ1

a

∫ 2

1
x−2 dx dy =

3

2
.

Question 3. By reversing the order of integration, one obtains∫ γ3

0

∫ γ3+1

x+1
f(x, y) dy dx =

∫ a

1

∫ y−1

0
f(x, y) dx dy.

Determine the value of a.
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Figure 6. Typing Question 1.

Accordingly, when typing Question 2, the formula =O18+J20 is stored in cell N30 to
acquire the value of β2 + γ1, and when typing Question 3, the formulae =L20 and

9



=L20+1 are stored in cells J36 and in the merged cells K36 and L36 to acquire the
values of γ3 and γ3 + 1, respectively (Figure 7).

Figure 7. The first three questions on the examination paper.

Next, we type all subsequent questions similarly. Notice that, to maintain tidiness,
we consistently lengthen the border rule which is drawn between columns AF and
AG, i.e., the vertical page-break (cf. the document’s print preview), and we let no
question be split by the horizontal page-breaks (Figure 8). (See section 5 for a reason
for this.)

Figure 8. Maximising tidiness by letting no question be split by the horizon-
tal page-breaks. Notice the location of Question 5. The page-breaks —dotted
lines— become visible if we have opened the document’s print preview at least
once.
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(5) Once the questions are all typed, we set the width of column AG to be 3.00 (cf. step
(1)); this column will be used for marking purposes.

(6) The reader who follows the procedure up to this step is now advised to make a copy
of the spreadsheet file for the purpose of following the marking preparations in section
4. The subsequent steps of the present section are to be implemented on the original
file.

(7) We unshow the gridlines for a clean, actual-examination-paper-like appearance. This
is done by unchecking the Gridlines checkbox on the View tab (Figure 9).

Figure 9. Unshowing the gridlines.

(8) Next, we select all cells, click the Format menu on the Home tab, and click Format
Cells. When the Format Cells window appears, we check the Hidden checkbox on the
Protection tab (Figure 10). This is done to make all formulae invisible later when the
sheet is protected.

(9) Before protecting our sheet, we must unlock all cells which will be filled out by students
during the exam: those which will store students’ names and ten parameters, and those
which will store students’ answers. This is done by selecting all these cells, clicking
the Format menu on the Home tab, clicking Format Cells, and unchecking the Locked
checkbox on the Protection tab on the Format Cells window (Figure 10).

(10) Finally, we are ready to protect the sheet. This is done simply by clicking the Protect
Sheet menu on the Review tab, entering a password for unprotecting the sheet —
decided by and known only to us as examiners— on the text box on the Protect Sheet
window which appears (Figure 11), clicking the OK button, and repeating this on the
Confirm Password window which will subsequently appear.

(11) The examination paper is now ready to use. The reader who follows the procedure up
to this final step is invited to inspect that, in this protected condition, cells other than

11



Figure 10. The Protection tab on the Format Cells window.

Figure 11. Protecting the sheet.

the unlocked ones are all uneditable, and formulae stored in various cells to acquire
values related to the randomisation parameters are all invisible. This disables students
from seeing how this examination was designed, in particular how the questions were
randomised.

12



4. Marking

The substantial part of the marking job lies in the preparation which we now explain. The
following reader could implement this preparation on the copy of the examination spreadsheet
which we advised to prepare in step (6) of the previous section. It is advisable to complete
this preparation before the examination day.

(1) Let us first discuss the marking preparation for Question 1. The correct answer to
Question 1, in its original, parametered form, is the following.

Answer 1. −2α3
4 + α3

2γ3
2 + 8α3

3 − 9α3
2

To mark a student’s answer to this question, we have to check whether the number
stored by the student in cell G27 —the answer cell of Question 1— equals to −2α3

4+
α3

2γ3
2 + 8α3

3 − 9α3
2, where α3 and γ3 are the third digit of the student’s year of

entry and the third digit of the student’s examination code, respectively, stored by
the student in cells O16 and L20, respectively. To perform this check, we store in
cell AG27 —the marking cell of Question 1 (cf. step (5) of the previous section)—
the formula

=IF(G27=-2*O16∧4+O16∧2*L20∧2+8*O16∧3-9*O16∧2;1;0)

which gives 1 if the student’s answer is correct, and 0 otherwise (Figure 12).

Figure 12. Entering the formula for marking Question 1.

Once the formula in cell AG27 is entered, the reader could check its correctness by
inputting, for instance, α3 = 2 and γ3 = 7 in cells O16 and L20, respectively, after
which the double integral to be calculated reads∫ 2

0

∫ 7

2y−3
4xy dx dy.
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Since∫ 2

0

∫ 7

2y−3
4xy dx dy = 2

∫ 2

0

[
x2y
]x=7

x=2y−3 dy

= 2

∫ 2

0

[
49y − (2y − 3)2y

]
dy

= 2

∫ 2

0

(
−4y3 + 12y2 + 40y

)
dy

= 2
[
−y4 + 4y3 + 20y2

]y=2

y=0

= 2
[(
−24 + 4 · 23 + 20 · 22

)
−
(
−04 + 4 · 03 + 20 · 02

)]
= 2 · 96

= 192,

in cell AG27 there should appear 1 if the integer 192 is stored in the answer cell G27,
and 0 otherwise.

Next, we treat all subsequent questions similarly.

(2) Finally, we store in cell AG162 —the one just below the last question’s answer cell—
a formula which calculates the student’s total mark. Assuming that each of the 20
questions are weighted equally and the total mark is to be an integer between 0 and
100 inclusive, the total mark is simply the sum of the numbers stored in all marking
cells multiplied by 5:

=SUM(AG27:AG161)*5

(Figure 13).

Figure 13. Calculating a student’s total mark.

The marking preparation is complete. We are now ready to mark a completely filled out
examination paper submitted by a student. To do this, we first open and unprotect the
submitted file by clicking the Unprotect Sheet menu on the Review tab and entering our

14



password (cf. step (10) of the previous section). After that, we simply copy the entire column
AG of the present file and paste it on column AG of the file submitted by the student. By
doing so, we immediately see the student’s total mark in cell AG162.

5. Guidelines and simulation

The newness of this examination format made it necessary for us to carry out a simulation
in the final class of the semester, taking place two working days before the examination. This
simulation, being a quiz in exactly the same format as the examination but consisting only
of 5 questions, aims (besides to check students’ understanding on materials) to familiarise
students with the new examination format6, and examiners with technical issues that may
be experienced by students during the examination and by examiners during the marking
process. Before the quiz took place, we gave out a guideline sheet to be read and understood
by all students so that no confusion will arise with respect to technicalities. The content of
the sheet include (but is not limited to) the following.

(1) Make sure that you know your own examination code.
(2) The quiz will be given in the form of an Excel (.xlsx) file containing 5 short-an-

swer questions. You MUST use MICROSOFT EXCEL to open this file.
(3) Every question has an integer answer.
(4) Fill out the form on the heading of the examination sheet (name, year of entry,

last three digits of ID, examination code) correctly BEFORE beginning the
quiz.

The significance of the second sentence of guideline (2) will become clear in subsection 6.2.
Guideline (4) was the most important one to be stressed in class; the explicit statement of the
same guideline on the quiz sheet (and later on the examination sheet; see step (3) of section
3 and Figure 5) served as a final reminder. An instruction on how submissions should be
made was also included in the guideline sheet, in addition to an advice to save the quiz file
periodically to avoid risks caused by sudden power outages, etc. Tables containing students’
examination codes were given out separately.

Students experience essentially no significant issues in completing and submitting the quiz
as instructed. However, they have varying levels of fluency in using Excel. Some reported
to the quiz invigilator —the second author of this paper— of seeing that, on their comput-
ers, some cells on the quiz paper contained #s instead of comprehensible contents. Excel
proficients knew that adjusting the magnification level solves this issue.

From the examiners’ side, we interestingly found out that approximately a third of students
taking part in the quiz submitted their work in an unprotected condition. Since the quiz took
place in Google Classroom, we believed that these students opened and completed the quiz
using Google Sheets rather than Excel (the consequences being described in subsection 6.2).
To reduce the probability of students doing this later in the examination, the examination
sheet were distributed not by attaching it on Google Classroom but by providing an external
link to which the sheet was uploaded, hoping that students clicking the link were automatically
downloading the file to be opened with Excel installed on their computers. We found this to
be an effective solution; in the examination there were no students submitting their work in
an unprotected condition. A guideline sheet for the examination —very similar to that for
the quiz— was also given out before the examination day.

6Depending on the students’ level of experience and adaptability, it may also be necessary to train them with
questions posed in such a format over the semester.
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6. Strengths and weaknesses

In this final section, we discuss some strengths and weaknesses of our examination format.

6.1. Strengths. The main strength of this examination format certainly lies in the

(1) possibility of assigning to each student a different type of each examination question,
making collaboration difficult and plagiarism impossible.

In our actual examination, however, not every question had this possibility (e.g., questions
containing only one parameter; see section 2), and for every question having the possibility,
we did not go to the trouble of absolutely ensuring that each of our 81 students was assigned a
different type, since our parameters —especially examination codes— were randomised. See
Figure 14 for a table detailing, for each question, the parameters on which it depends, the
number of available types it has, and the number of students answering it correctly.

Question
Parameters Number of Number of Number of students

α1 α2 α3 α4 β1 β2 β3 γ1 γ2 γ3 parameters available types answering correctly

1 X X 2 18 65
2 X X 2 81 72
3 X 1 9 65
4 X X 2 81 62
5 X X 2 81 34
6 X X X 3 729 63
7 X X X 3 81 52
8 X X X 3 81 64
9 X X X 3 162 55
10 X X X 3 72 64
11 X X 2 81 62
12 X 1 9 73
13 X X 2 81 65
14 X X 2 81 79
15 X X X X X X X X 8 1049760 75
16 X X 2 81 53
17 X X 2 81 61
18 X X 2 18 68
19 X X X X 4 1620 73
20 X X 2 81 52

Figure 14. The parameters contained in, the number of available types of,
and the number of students correctly answering each question.

Plots of the number of correct answers, versus the number of parameters and versus the
natural logarithm of the number of available question types, are displayed in Figure 15.
Each plot suggests that no correlation exists between the variables in the respective axes.
Therefore, the rare and randomly-occurring opportunities of collaboration due to a small
number of questions having only a few types, as discussed in section 2, were not exploited
by students. We believe that this is because these opportunities were not visible enough; the
opposite could have happened if, e.g., each of our 20 questions were made to depend only on
one parameter.

Furthermore, our examination format is beneficial to examiners due to its

(2) reduced marking effort,

and to students due to its

(3) easy submission process.
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Figure 15. Plots of ordered pairs, each of which representing a question: its
second component is the number of students answering it correctly, and its
first component is the number of parameters it contains (left panel) and the
natural logarithm of the number of available types it has (right panel).

In each of our three previous examinations, the students’ submission process consists of five
major steps: scanning or photographing their handwritten answers, converting the resulting
images into PDF files, merging these into a single PDF file, renaming this file as pre-instructed,
and uploading this file on the designated submission site. With our new examination format,
the first three steps are not necessary. In addition, our examination format is also

(4) paperless.

Finally, although our examination format may be similar to those created on online platforms
such as Numbas or WeBWorK, our format allows

(5) offline production process, using one of the most popular spreadsheet software [9].

6.2. Weaknesses. As already apparent from previous sections, this examination format de-
mands

(1) a thorough and potentially time-consuming preparation.

In addition,

(2) the integer-answer, numerically-randomised format of its questions favours computa-
tional questions, and enables students to use computer algebra systems to complete
the examination7.

Indeed, such a format is suboptimal for examining students’ conceptual accuracy, let alone
proof-writing proficiency (cf. [5, 19]). (Nevertheless, some methods have been developed for
online-assessing the latter [3].) While it might be easy to incorporate to our format —if at all
desired— multiple-choice questions (each of whose answers being the letter representing the
student’s choice, similarly randomised and marked), this is not the case for essay questions,
for which we have not found an equally-efficient marking mechanism.

On the practical side,

7Obviously, this is not a weakness if this format is used for a course on a computer algebra system.
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(3) not all students have Microsoft Excel on their computers,

especially those whose computers run non-Microsoft operating systems. If they are only a mi-
nority, they could be instructed to inform the examiners several days before the examination.
For each of them, the examiners could provide an adapted examination sheet; this is in the
form of the PDF conversion of the original examination sheet in which the heading form has
been filled out by the examiners with the respective student’s data to generate the questions’
numerical details accordingly. They are then instructed to submit their answers in the form
of another PDF file. As a consequence, however, some extra effort is needed to mark their
answers.

Another practical weakness of this format is that

(4) Excel’s sheet-protection and cell-locking mechanism in a spreadsheet do not function
if the spreadsheet is opened without using Excel, e.g., using Google Sheets.

Thus, any student who opens the examination sheet using Google Sheets is able to see all
the randomisation formulae, and to edit any cell. This clarifies the significance of the second
sentence of guideline (2) in section 5. However, students editing a question (e.g., to make the
numerical details exactly the same as those received by a classmate, with whom they can then
collaborate) are merely straying themselves, since during the marking we will nonetheless use
the answer key to the original question.

To conclude, it will be useful if one could develop an offline software which facilitates and
optimises the implementation of the examination mechanism described in this paper. With
such a software, it is hoped that the examination sheet could be produced in a format which
can be opened and worked on by all students without the need to have a particular software on
their computers, and that there is no way for them to see and tamper with the randomisation
mechanism.
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